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PLEDGE

India is my country. All Indians are my brothers and sisters.

I love my country, and I am proud of its rich and varied heritage.

I shall always strive to be worthy of it.

I shall give respect to my parents, teachers and all elders and treat everyone
with courtesy.

I pledge my devotion to my country and my people.

In their well-being and prosperity alone lies my happiness.



Dear learners,

Information and Communication Technology (ICT) has, within a very short span of time, turned
out to be one of the basic building blocks of modern society. Many countries now consider
understanding ICT and mastering its basic skills and concepts as part of their core education
policy.

While there have been many new technologies being introduced from time to time, with ever
increasing rapidity, nothing has made as far reaching an impact as Information Technology.
Today, students require strong technology skills to succeed in every sphere of their endeavour.
Moreover, Information Technology is endowed with a platform for student inquiry, analysis and
construction of new information.

Children, you have been interacting with the computer from the primary classes. The goal we
have set here is not restricted merely to Information Technology alone but it’s also meant to
expand the boundaries of your creativity through the use of advanced computing and telecom-
munications technology. The process of classroom learning can become significantly richer as
students gain access to new and different types of information.

Numerous software available today  facilitate graphic displays and controlled experiments in
ways never before possible through which students can communicate their results and
conclusions to their teacher, students in the next classroom or even to the students around the
world in a variety of media.  Each chapter in this book packs a lot of information to captivate and
more importantly to motivate you and ultimately take you towards greater learning!

This book is a journey through the processes like drawing, composition of a news magazine and
various games. Getting familiar with computer software like spread sheet to tabulate the
collected details, make attractive multi-media presentation and IT based information in
connection with the core subjects like Mathematics, Social Science, Basic Science and Geogra-
phy that will engage the students more fruitfully in their learning process is also included in this
journey.

Networked computers with internet connectivity can increase learner motivation as it combines
the media richness and interactivity with real people and to participate in real world events. As
you are surrounded by all the other applications of the technology, you will get an opportunity to
handle the computer effortlessly. The activities designed in each chapter are based on various
subjects that will enhance your knowledge. Make a voyage through this ocean to enrich your
information.

Hope this textbook will steer the students’ path towards higher education and will prepare them
for a productive career path. May you freely soar high up in the boundless world of technology
and use the new technology to your best advantage!

With warm wishes,

Prof. M.A Khader
Director
SCERT
Thiruvananthapuram
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CONSTITUTION OF INDIA
Part. IV A

FUNDAMENTAL DUTIES OF CITIZENS

ARTICLE 51A

Fundamental Duties - It shall be the duty of every citizen of India :

(a) to abide by the Constitution and respect its ideals and institutions, the
National Flag and the National Anthem;

(b) to cherish and follow the noble ideals which inspired our national struggle
for freedom;

(c) to uphold and protect the sovereignty, unity and integrity of India;

(d) to defend the country and render national service when called upon to do
so;

(e) to promote harmony and the spirit of common brotherhood amongst all
the people of India transcending religious, linguistic and regional or sec
tional diversities; to renounce practices derogatory to the dignity of women;

(f) to value and preserve the rich heritage of our composite culture;

(g) to protect and improve the natural environment including forests, lakes,
rivers and wild life and to have compassion for living creatures;

(h) to develop the scientific temper, humanism and the spirit of inquiry and
reform;

(i) to safeguard public property and to abjure violence;

(j) to strive towards excellence in all spheres of individual and collective ac
tivity so that the nation constantly rises to higher levels of endeavour and
achievement.

(k) who is a parent or guardian to provide opportunities for education to his
child or, as the case may be, ward between age of six and fourteen
years.
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1.  Sketches and Colours

“Crowded by thickets in bloom
Soaked in emerald green
Lay the captivating countryside
In its pristine beauty and elegance”

How do you find the
illustration of the landscape that
Changampuzha, the celebrated
Malayalam poet, described in
his famous poem Ramanan?
(Picture 1.1) It was created on a
computer. Do you like it?

Poetic narratives appear as images
in our mind, don’t they? Wouldn’t you
also like to create such images using a
computer?

You are already familiar with
software assisted drawing. Try to
recollect the features that you used in
such software. Let’s now familiarise

ourselves with a similar software with
more features.
Where to draw?

Now let’s prepare a space to draw
a picture. For this, go to the ‘File’ menu
of the GIMP software, and click ‘New’.
Click ‘OK’ in the new window that pops
up. A window for drawing a picture
opens (Picture 1.5). The white rectangle
in the middle is the area for you to draw.

Pic. 1.1 A picture made using GIMP
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The  paintings that won the first and second places in the paintings competition using GIMP
as part of the State  School IT Festival 2009.

Pic. 1.2

Pic. 1.3
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Pic. 1.4 GIMP -
The main window

GIMP

GIMP is the acronym for
GNU Image Manipulation
Programme. It is a free software
used for drawing, image editing,
preparation of logos, and
animation. It is ‘GIMP Version 2.2’
that is used in this chapter. In
order to open the software, go to
‘Applications’ menu, select
‘Graphics’, and click on the tab
‘GIMP Image Editor’. The main
window in GIMP appears with
tools in it (Picture 1.4).

Pic. 1.5 GIMP - The drawing Window
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Pic. 1.6

See the main window of
GIMP software. Several
tools that help us in
drawing and painting are
given there. The name of
each tool can be displayed
by bringing the mouse
pointer over the tool. Try
using the numbered tools
in Picture 1.6, one by one.
Then fill up the following
table with the name and
use of each tool.

Tool    Name of the Tool Use the Tool

1. Pencil Tool Use to draw like a pencil

2.

3.

4.

5.

6.

7.

Now that you are familiar
with the tools used in
digital drawing, let’s start
drawing a picture.

Select ‘brush’ tool, choose
a colour, and use it to draw a
picture. Draw whatever comes
to your mind. Use ‘fill’ or
‘bucket’ tool to colour it. See
how the picture comes up. If
you are not satisfied, try
different colours. Tools in this
software are like pencil and
pen. Use them again and again.

Knowing to use a pen
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Saving Pictures

Pic. 1.7 ‘Save Image’ Box

While saving a picture,
in addition to the file
name, we have to specify
an ‘extension’ as well.
The ‘extension’ signifies
the file format. GIMP can
handle various formats.
However, its own format
is ‘xcf’.

In order to save a picture in GIMP, select ‘Save’ from the ‘File’ menu. In the
window that opens, type file name in the ‘Name’ box, select ‘xcf’ by clicking on
the ‘Select File Type’ tab, and click ‘Save’.

Clone Tool

‘Clone’ tool is used for copying a picture exactly from one part of the drawing
space to another. (Clone tool is marked ‘8’ in Picture 1.6).

♦ Select the brush of appropriate size from the brush window.
♦ Bring the mouse pointer to the picture to be copied. Click on the picture

while keeping the ‘Control’ key pressed.
♦ Take the mouse pointer to the place where you want to copy the picture.

Move the mouse while keeping the left mouse button pressed. By
dragging the mouse pointer adequately, the picture can be copied fully
or in part as required.

alone does not make one a writer. Pen
is just a tool. One needs to have
creativity and imagination to become a
writer. Similarly, if you want to become
an artist, you should be able to use the
tools in GIMP to express your creativity.
Keep experimenting with tools. That’s
how you will become capable of
expressing your creativity using the
tools. Capable of creating pictures in
your own style.

You have created a picture and
saved it as a file. Now let’s consider a
few activities.

Activities

1. Do the following using GIMP for
a digital magazine for your class.

(a) Make a painting of a sea shore
in the evening

(b) Prepare the cover page for the
magazine

(c) Prepare illustrations and page
lay out for the poems in the
magazine

2. Redo the illustration used for
the poem Kannikkoithu in your
Malayalam textbook using
GIMP.
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Pic. 1.8 Pic. 1.9 The window for making logos

3. Visualise the sunrise in the
Western Ghats and draw it in
GIMP.

Creating a logo in GIMP

By now, you must have
understood how to make drawings and
paintings using GIMP. We can use this
software to create beautiful titles and
logos as well. Let’s see how these can
be done.

Open GIMP software, click ‘File’
menu, select ‘Xtns’, then select
‘ScriptFu’, and click on ‘Logos’ (See
Picture 1.8). You can now see a list of
title types in various styles.

Now select one of the title types.
For instance, suppose you have selected
‘ScriptFu:3D Outline’. Type your name
in the tab marked ‘Text’ in the window
that opens. You can make title types in
Malayalam also using GIMP.

Remember the way we saved the
pictures in GIMP? Similarly we can save

the titles and logos in ‘xcf’ format. There
are other formats such as ‘png’ and
‘jpeg’ in which these can be saved. In
order to do this, click ‘Save’ after
selecting the appropriate format by
clicking the tab ‘File Type’ in the ‘Save
Image’ dialogue box. The size for the
same file is much lower in ‘png’ and
‘jpeg’ formats compared to ‘xcf’.
Activities

• Prepare a title for the science wall
magazine of your class using
GIMP.

• Prepare a poster on the
importance of water conservation
using logos in GIMP.

• Prepare a poster advertising the
energy conservation campaign of
the Energy/Environment
Conservation Club in your school
using logos.
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2.  Understanding Time Zones

Help 2.1
Use the following sequence to open
the Sunclock: Applications  →
Education → Sunclock

You know how to use computers
for different purposes. You have also
used them to learn other subjects. Let’s
see how we can enhance our
understanding of some of the topics in
Social Science using computers.

Read the following matter and
discuss the reasons behind them :

• Inaugural match of the last football
world cup was held in Munich on
9th June 2006, at six o’clock in the
evening. We saw the live telecast of
the same match at 9.30 in the night
the same day.

• The killer waves of the Indian ocean
tsunami of 26th December 2004

originated off the Sumatra Island at
9 AM, Indonesian time. These waves
travelled through the sea for two
hours and hit the Kerala coast at 9.30
AM, Indian standard time, killing
hundreds of people.

Don’t you think it is worth
understanding this time difference in
more detail? ‘Sunclock’ is a free software
that would help you in this.

Remember the activities relating

to ‘time zones’ suggested in your Social
Science text. Now be prepared to
engage in those activities, using
‘Sunclock’. Directions given in Help 2.1
will help you in opening the ‘Sunclock’.

Sunclock

Sunclock is a software application that delineates the countries experiencing
day or night at a given time on a world map using light and shade. Numerous
facts including time differences across countries, distances between regions,
and longitudes and latitudes of various places are available on Sunclock.
Sunclock offers geographical information including positions of the sun and
the moon at a given time on a given day.
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Pic. 2.1 Sunclock Window

Help 2.2

Use the following sequence to see the
world map showing countries:
F button → vmf → Countries. vmf

Pic. 2.3 The window for selecting various maps from

Help 2.3

Use the following sequence to see the
world map delineating land and sea :
F button → vmf → landwater.vmf

In order to access ‘Sunclock Tool
Bar’, click anywhere inside the
‘Sunclock’ window (Picture 2.2). Bring
the mouse pointer over the buttons on
the ‘Sunclock Tool Bar’ and see the
function of each tool.

Days and Nights

Take a close look at the map in the
‘Sunclock’ window. Some countries are

covered by a shade while others are
clearly visible, as if in sunlight.
‘Sunclock’ uses this representation to
show countries that have night and day
at a given point of time. The countries
that are visible are the ones in day, those

             Pic. 2.2 Sunclock Toolbar

under the shade are passing through the
night.

Use the steps in Help 2.2 to open
countries.vmf and see the world map
showing the various countries
delineated by boundary lines.
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Pic. 2.4 World Map

  Towards West                    Towards East
  Longitude Day Time Longitude Day Time
15º Monday 7 am 15º Monday 9 am
30º Monday 6 am 30º Monday 10 am
45º 45º
60º 60º
75º 75º
90º 90º
105º 105º
120º 120º
135º 135º
150º 150º
165º Sunday 9 pm 165º Monday 7 pm
180º 180º

Take a closer look at the world
map. Do you dream of a world in which
people’s love and respect towards one
another transcend all manmade
boundaries? A world in which there are
no boundaries at all?

Can you prepare a list of countries
that experience night while India is in
broad day light? Try clicking the ‘N’
button in the ‘Sunclock Tool Bar’
continuously (Picture 2.4). What
happens if you keep pressing the ‘N’
button even after the night fades away
completely? Can you find out?

Use the directions in Help 2.3 to
visualise the world map
that shows the land and
the sea separately. Can
you assess the proportion
of area covered by the
land and the sea?

Time Zones

As a first step
towards studying time
zones, click the ‘W’
button on the ‘Sunclock
Tool Bar’. Time zone map
appears in the ‘Sunclock’
window (Picture 2.5).
• Find out the time

difference for each
shift by 15 degrees
towards west from the
zero degree longitude,
ie., from the prime
meridian.
• What is the
difference between
Indian Standard Time
(IST) and Greenwich
Meantime (GMT)? Can
you explain this

difference using the longitudinal
time difference of one hour for every
15 degrees?

Help 2.4

• Open Sunclock zoom window by
clicking on ‘Z’ button (Picture 2.6)

• Note the vertical and horizontal
scale bars on the screen. By
dragging the mouse pointer on the
scale bars, we can select an area
that we want to see in detail.
Select African continent using this
method.

• Click the ‘+’ button to zoom in
onto the selected area.
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Pic. 2.5 Time Zone Map

• Can you compute the time at the
longitudes given below, at 8 AM,
GMT?

• How many hours would be the time
difference between 180 degrees East
and 180 degrees West?

As shown in Help 2.4, it is possible
to select a place and zoom in to watch
more clearly.

Can you zoom in onto the African
continent and see how many time zones
has the continent  been divided into?
(use suggestions in Help 2.4).

Discuss the issues if India was
divided into more time zones?

Latitude

Lines of latitude, also called
‘parallels’, can be seen on the time zone
map as directed in Help 2.5.

Locate the following lines of latitude.
• Tropic of Cancer

• Equator

• Tropic of Capricorn

• Arctic circle

• Antarctic circle

Prepare a list of countries through
which the Equator passes.

Help 2.5
♦ Show the time zone map by clicking on ‘W’ button
♦ Double click on ‘T’ button to see lines of latitude
♦ Double click ‘P’ button to see lines of latitude with 10 degree gaps
♦ Double click ‘Y’ button to locate the longitudinal positions of the sun and

the moon
♦ Click on ‘U’ tab to see the location of cities on the time zone map. See the

information displayed below the window when you bring the mouse pointer
on a city’s location.
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Pic. 2.6 Zoom-in-window

Using Animation

‘Sunclock’ atlas captures the
changes commensurate with every
second of earth’s rotation. In place of
every second, we can adjust the speed
of change in the atlas for every minute,
day, week, or month. ‘G’ tab helps you
to do this. Animation can be activated
as shown in Help 2.6.

Shadow Clock

All of us know that the night does
not set in at the same time all
throughout the year. There are seasonal
differences. By arranging the dates on
the ‘Sunclock’, it is possible to see the

change in timing in the setting in of the
night. Please use Help 2.7.

Does the night commence at the
same time in Kerala and Delhi, on a
given day?

Set the time difference at one
minute and see the time lapse between
sun rise across the various parts of India.
Set the Time Zone Map to March 23,
September 21, and December 22 and
activate animation. See the difference in
timing of sunrise and sunset in different
parts of our country.

We have seen the position of the

Help 2.7

♦ Click G button to set the time
difference as required.

♦ Use A button to set the time
forward

♦ Use B button to set the time
backward

Help 2.6

♦ Click the G button to set the re-
quired time.

♦ Open the window by clicking 'O'
button. Activate animation by
clicking on     tab.'
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sun using animation. Based on this,
observe the change in the position of the
shadow in the Shadow Clock. Seek the
support of your teachers if required.

More Activities

• By observing the Sunclock Time
Zone Map, find out the time at
which people in India actually saw
the live telecast of the inaugural
ceremony of Sydney Olympics held
at 8o’clock in the morning,
Australian time.

• Identify the time zones in Russia
using Sunclock.

• ‘When the solar time is 4.10 evening
in Kolkota, the same would be 3.08
in Mumbai’. Use sun rise timings to
see whether this statement is true.

• Spot countries in African and
European continents which lie in the
same time zone.



When you flip through the text
books, colourful magazines and

Pic 3.2

3. A News Magazine for Us

daily newspaper, have you ever won-
dered how they are brought out? The
news stories and features that reach you
are printed with the help of machines.
Two such printed pages in Malayalam
are given here. One is from an old In-
dian history text book while the other
is a recent newspaper report on
Chandryan.

Pic 3.1

13
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The matter in the first picture was com-
posed through manual type setting, a
method used in the past, the newspa-
per shown in Pic.3.2 was printed using
modern technology. Printing technol-
ogy has undergone a sea change with
the advent of computers.
You know how to prepare a document
using computer? What are the different
types of software that help you prepare
a document? Prepare a list of such soft-
ware.
• G  Edit
• Open office writer
•
•
How to open these software applica-
tions?

G Edit
Applications → Accessories
...................................................................
....................................................................
....................................................................
....................................................................

Open office Writer
Applications → Office
...................................................................
....................................................................
....................................................................
...................................................................
Most of the magazines are colourful and
eye-catching. How are they made so at-
tractive? How is a paragraph in your
textbook created? What are the features
of a paragraph in your textbook? What
all have been done to make paragraphs
more attractive? Write down those
points.

Equal space between the lines
Same font size
The lay out made attractive by add
ing pictures

Compare the pictures 3.1 and 3.2. Analyse the peculiarities of the print in both.
Pic. 3.1 Pic. 3.2

Old age printing................................ ...............................................................

......................................................... ...............................................................

......................................................... ...............................................................

......................................................... ...............................................................

•
•
•
•
•
•
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........................................................

........................................................

........................................................

........................................................

........................................................

........................................................

........................................................

........................................................

........................................................

........................................................

Let’s make a news magazine

You are already familiar with develop-
ing handwritten magazines in your
school.  Now, let us make a news maga-
zine using computer. This news maga-
zine can also be printed later. Let’s
prepare it by using your own stories,
poems, essays and pictures. The work

After typing the message structure it
into a beautiful paragraph  to enhance
its appeal.
....................................................................
....................................................................
.....................................................................
....................................................................

Select the typed paragraph and click on
the Paragraph Tab in the Format Menu.
What are the Tabs you view in the
window that opens? Try to make
changes using the facilities in the Tabs.
Make list of the use of the Tabs that you
get in the window.

begins with the collection of poems, sto-
ries and pictures of your friends. If nec-
essary, get the help of your teacher to
get suitable pictures from the internet.
The first step is to discuss the contents
to be included in the magazine. A mes-
sage from the headmaster can be typed
first. Type this message in your
computer.

Printing – an amazing development in
information technology

Imagine a world with no written words. Speech was the only medium of
communication for our ancestors to convey their ideas and share their
knowledge. Later, with the information being stored in palm leaves, one
could preserve and transfer knowledge to the future generation without
losing its accuracy. With the invention of printing press one could exchange
information to a large section of the society. With computers replacing
manual type setting, quality  of printing took a giant leap forward.

Message
Wow! Turning pages of this magazine is like seeing a rainbow - I am amazed
at the variety of your creativity and also the hard work you have put in com-
piling this magazine. I see many sparks of innovative ideas, which have the
potential to lead the thoughts of the society in the future. I wish and hope that
you will now work towards making these a reality.
Best wishes.
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How to make a paragraph look beautiful

To make the paragraph look beautiful one has to set space between the lines,
between paragraphs, borders and background colour.  To modify a paragraph
select that particular paragraph and click on the Paragraph Tab in Format Menu.
A window opens with ready-to-serve tools.

Pic. 3.3

1. Background: To change the back
ground of the paragraph

2. Indent spacing: Spacing between
lines and paragraphs

3. ............................................................
4. ............................................................
5. ............................................................

a. Before Text: Space from margin
b. After Text: ........................................
 c. Above Paragraph:  .........................

...........................................................
d. Below Paragraph: ...........................

............................................................
e. First Line:  ........................................

............................................................

You have just been introduced to the
Tab that helps to modify a paragraph.
Try to modify the headmaster’s
message.

Type the stories and poems in
Malayalam

You have already learned how to type
Malayalam letters in computer. Get
ready to type the stories and poems
contributed by your friends. Find out
the Malayalam letters that you get when
you press the English alphabets in the
key board. Start typing with the help of
the key board (Pic 3.4)
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Pic. 3.4
Editor’s Letter

Ajayan has been elected as the Editor
of your school magazine.  The editor’s
words should appear in the second
page introducing the Magazine. For
this, a new page has to be added. What
are the methods available for doing it?

The pictures 3.5 and 3.6 explain the
method of adding new pages to your
news magazine. Type the editorial fol-
lowing the methods you have learned
and make the paragraph more attrac-
tive.

New pages can be easily added in the Open Office Writer file. The cursor
automatically moves to the next page after the completion of the existing
page. If not, bring the cursor at the end of the completed page and proceed
with the Manual Break in the Insert Menu to add more pages.

 From the Editor’s Desk

We have pleasure in presenting the creative works of the young, budding tal-
ents ,,,,,,,,,,,,, ..............................................................................................................
......................................................................................................................................................

.................................................................................................................................................................................

.................................................................................................................................................................................

.................................................................................................................................................................................

.................................................................................................................................................................................

................................................................................................................................................................................
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Pic. 3.5

Pic. 3.6
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............................................................
3. ............................................................

............................................................
4. ............................................................

............................................................

Sreekutty’s English Story

Sreekutty has contributed an English story to your magazine. Include it in the
next page. Type the story and follow the methods of paragraph setting.

Prepare a list of the Tabs used.

1. Drop Caps
2. ............................................................

Observe the paragraph given below. Find out the Tabs used to make the follow-
ing paragraph attractive.

THE MICE THAT SET THE ELEPHANTS FREE

There was once a ruined village. The mice were the old settler there.
They occupied the chinks in the floors of the houses and temples with their
children and grand children. They found happiness in a variety of festivities.
In to this scene came an elephant king, whose retinue numbered
thousands. He, with his herd, had started for the lake in search of water. As
they marched through the mouse community, the elephants crushed the faces,
eyes, heads and necks of many.

While typing the story you would have noticed red lines under a few words.
Why? Discuss the matter with your peer group and teacher.

 A Dictionary inside the Computer

A dictionary is included in the IT@school/gnu/linux of your computer. This
computer dictionary compares each typed word with the similar words in the
dictionary and a red underline appears if there is an error. The red line also
appears under the words that are not in the computer dictionary. (Eg: The names
of persons and places of our local area).  These words can be included in the
dictionary, if needed.

THE LION AND THE BULLS

Once three gient bulls lived in a jungle. They were great friends. A lion de-
sired to kill them and eat them. But every time he went after the bulls, they
jointly attacked the lion and drove him away.
The lion therefore knew that he had to destroy the friendship and unity of the
bulls. So he called a fox and asked him to make them quarrel among them-
selves. He promised that he would reward the fox handsomely.
The cunning fox went to work. He told each bull false stories about the oth-
ers. Within a short time the bulls began to quarrel among themselves. They
started going about and grazing separately. Te lion easity killed and ate them
all one by one.
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The incorrect words in the story of
Sreekutty can be corrected. To do so,
bring the mouse on the red underlined
word and right click. What do you see
now? A box appears with a few words
similar to the underlined word. Select
the correct word from it and clear the
errors.

Notes of Saleena

Each unit in your English text has the de-
tails of the writers and poets. Saleena has
collected more details of these writers as
well as profiles of other prominent au-
thors from the internet with the guidance
of her teacher. Include this information

in your magazine. Let’s find out the
method to include pictures now.
When you click the Insert Picture from
File, a browser window opens. Select a
picture from the window. The Pic 3.8

Pic. 3.8

Pictures along
with articles

Pictures can be included along with
the article using the Open Office
Writer.
Insert → Menu → Picture from File
is the pattern for navigation.

Pic.3.7

shows the way to select Picture 1 from
the desktop folder Image 1. After select-
ing the picture click Open and the pic-
ture appears in the page where your
article has been typed.
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Follow the pattern demonstrated here to add the profiles of the writers that Saleena
has compiled from the internet.

Pic 3.9

Pic 3.10

Pic 3.11

WILLIAM SHAKESPHERE

The greatest poet and
playwright in English
Literature was born at
Stratford-upon-Avon in
Warwickshire, England

N. KUMARAN ASAN

N.Kumaran Asan   also
known as Mahakavi
Kumaran Asan, the pre-
fix Mahakavi awarded by
Madras University in the
year 1922 means “Great Poet”.

Pic 3.12

(1564-1616) (1873-1924)

Tables can be included in the articles

In the article written by Ratheesh on Water Conservation, a table has to be
included. Now let’s see how to add this table to the article.
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Sources Those who use Those who use Those who use
well water rain water tap water

Drinking 10 5 15

Cooking 15 7 18

Washing 40 0 10

Bathing 42 0 8

  Other pupose 30 0 20

Bring cursor to the place where the
Table has to be included. Click the In-
sert Table in Table Menu and a new

Pic. 3.13

window opens. Click OK button after
adding the required number of columns
and rows. Now insert details.
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How to make Tables attractive

There are various techniques to make
the table attractive. The background
colours, columns or  rows, dimension
of the columns, font size etc can be
changed.  The columns and rows can

be altered using the mouse pointer.
There are tools in the Table Menu to
bring about more changes. Find out the
various tools in the Table Menu.  Iden-
tify their applications and note them in
the table below . Remember to select
appropriate cells before using the tools.

Pic. 3.14

Tools Uses

Insert
Rows

Column

Table

Delete Rows

Column

Table Table

Select Rows

Column

Cells

        Merge Cells

        Split Cells

Prepare a table for the magazine with the details of students in each class. A model
is given below and you can use it with necessary changes.
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....................................................................................................................... School

..........................................................................................................................................................
Statement of Students

Class Previous Year - No. of Students Current Year - No. of Students

Boy Girl Total Boy Girl Total

I

II

III

IV

V

VI

VII

VIII

IX

X

Total

Numbering the magazine pages

Each page in your text book is num-
bered.  How is this possible?  And how
can your magazine be numbered? For
numbering a page, at first one has to add
a Header or Footer to the page.  For this
click the Header/Footer in the Insert
Menu. Drag the mouse pointer to the

area where the number has to be placed
and click Insert Field → Page Number.
Notice the change occurred in the se-
lected position. All pages can thus be
numbered.
Make the news magazine more attrac-
tive by including all the contributions
of your friends.
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4.  Knowledge at your finger tips

Pic. 4.1 Pic. 4.2

1. Computer Network

You must have kept the pictures,
letters, and documents that you have
prepared by saving them in your folders
in the computers at your school.
Whenever you want, you can open
them, use them, and modify them if
needed.

It would be convenient if your
friends can see your documents and
pictures on their computers, and help

you in editing or improving them.
Similarly, it would be handy if you
could also help your friends by working
on their documents and pictures on your
computer. Being able to share
information across computers would be
a major advantage while working on
common assignments.
Activity 1.1

Let’s draw a picture together

You already know how to draw
pictures in ‘XPaint’ window. Let the
friends using the first computer in the
computer lab draw the following
picture in the window and save it in
your group’s folder on their desktop.
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Pic. 4.4

Pic. 4.3

Can the friends using the second
computer open this picture on their
computer and make changes in it?

Open the picture that the friends
in the first group drew with the help of
your teacher, on your computer. Now

you may add one more figure in the
picture as shown in Picture 4.3. Please
do save the file in the group’s folder.

The third group can further add a
figure. Now what you have is shown
in Picture 4.4. Save it. Let other groups
also open the picture and modify
according to their imagination.

How is that we are able to open a
picture saved in one computer and
work on it on another computer?

• ...................................................................

• ...................................................................

Can you use the same method to
share the work of the digital magazine
and work on it collectively from
different computers?

• ..............................................................
..............................................................
..............................................................

• ..............................................................
..............................................................
..............................................................

• ..............................................................
..............................................................
..............................................................

Activity 1.2

What are the advantages of
linking computers together?

Activity 1.3

All of you have saved the pictures
that you have made using ‘GIMP’
software in your folders in the
computer. Share the pictures among
your friends through computers. Open
the pictures made by your friend in
your computer, modify it, and save the
modified copy in your folder.
2. A journey through Greenland

Remember the letter from a
student in Greenland given in the first
chapter of the Social Science text? That
was where we read about time zones
and climate zones. You must have
wished to see thatbeautiful place while
reading that letter. Can you imagine the

Pic 4.5
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Types of Computer Network

♦ For computers to share information, they have to be networked.
♦ There are two types of computer networks.
♦ When the computers in a room or a building are networked, it is called

a Local Area Network (LAN). The computer network in your school lab
is an example of LAN.

♦ Wide Area Network (WAN) are networks that connect computers over
a very large area. The computer networks used by banks to connect
their branches and ATMs and the all India tickets reservation system of
the Indian Railways are examples of WAN.

Internet
Internet is a global computer net-
work. We can access Internet by con-
necting our computer to it.

Opening Web Browsers

Click on the menu/tab in the fol-
lowing order :
Applications J Internet J Mozilla
Firefox /Isewessel

In order to open websites on the
Internet, open any of the we browsers
such as Mozilla Firefox, Icewessel or
Opera. Type down the address of the
web site you are looking for in the
address bar (Eg. www.greenland.com)
and press ‘Enter’. We should know the
names of the web sites to visit them
on Internet.

probable differences between
thegeographies of Kerala and
Greenland?

Polar bears, penguins, snow-topped
mountains...if only we could visit that
place!

But Greenland is so far away. Let’s

try to enjoy its landscape a bit by seeing
pictures and films about  it on our
computer. This cannot be as good as
actually experiencing it, still let’s try.

It is possible that some of the
computers in your school lab have
pictures and films of Greenland. Some
CDs may be available as well. In that
case we can make use of them. But what
do we do if nobody in the school has
got anything on Greenland with them?

Pictures and video documentaries
on Greenland must be available in
numerous computers in several places
in the world. Can we access them? Can
we connect to those computers in other
parts of the world and access
information? May be we should try.
Activity 2.1

Let’s open a web site on
Greenland in a computer connected to

Saving a picture

Bring the mouse pointer above
the picture to be saved, and click the
right button. A menu appears. Select
‘Save image as’ option from the
menu and save the file on your
desktop.
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Pic. 4.6  The homepage of the official website of the Government of Kerala

Internet in the school lab. We have to
use a ‘web browser’ for this.

What are the scenes that you see
on the computer screen? Mountains
covered in snow, polar bears roaming

around, penguins moving in a row...
very similar to what that friend from
Greenland had written in his letter. Look
for more details in the window.

A few official Websites

Government of Kerala - www.kerala.gov.in
Director of Public Instruction - www.education.kerala.gov.in
IT @ School Project - www.itschool.gov.in
University of Kerala - www.keralauniversity.ac.in
Department of Tourism, Kerala - www.keralatourism.org
 Local Self-Government Department - www.lsg.kerala.gov.in

Note down what you have seen:

1 .................................................................

2 ................................................................

3 ................................................................

Can that student in Greenland
understand about our country and its
geography using computers?

You have seen pictures and got

several information about polar
regions. Can you save one of these
pictures in your computer? Try saving
any picture.
Activity 2.2

Remember the letter from a
student in Indonesia in your Social
Science text? Can you collect
information on Indonesia from the
Internet?
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Activity 2.3

Visit the web site of the
Government of Kerala and note down
the important information available.

....................................................................................

.....................................................................................

Searching on Internet

We rely on ‘search engines’ to
search and find information on the
Internet. In order to search using the
search engine ‘Google’, type in the key

Pic. 4.7 -  Google homepage

words of the information that we need
in the search box in Google’s home
page. We can search for information in
almost all the important Indian
languages. Remember to provide space
between words if you are using
multiple keywords.

Activity 2.4

Remember what you have
studied on our digestive system in the
13th chapter of the Science textbook. As
part of your studies, can you search for
pictures on human digestive system
from the Internet? Lot of information on
the human digestive system is available

Saving an Information

You can copy the information to
be saved and paste it in a writer
window or text editor and save the
file.

Search Engines
Search engines help you to find

information even if you do not know
the exact address of the web sites.
Some of the important search engines
are www.google.com, www.yahoo.com,
www.msn.com, www.altavista.com,
www.excite.com, www.bing.com. All
these are available on Internet.
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History of Internet

♦ An experimental computer net-
work called ARPANET was es-
tablished on 2nd September 1969.

♦ It was a scientist named Paul
Baran who played the key role in
the development of ARPANET.

♦ When Winton Surf took over as
the chief of ARPANET, the Project
took a different path. He is known
as the father of Internet

♦ India got connected to Internet on
15th August 1995.

Searching for Pictures

You can search exclusively for
pictures by selecting the ‘images’ tab
typically provided on the top portion
of the web site’s home page.

on Internet. Do we need to know the
names of all the concerned web sites to
access information?

Let’s try searching for information
on the human digestive system on the
Internet.

Pic. 4.8. Article on Sree Narayana Guru in Malayalam Wikipedia

Activity 2.5

You have been asked to prepare
profiles of Sree Narayana Guru,
Ayyankali, and Chattampi Swamikal by
your Malayalam teacher. Can you use
Internet to access information on these
great persons and prepare their profiles
in Malayalam?

Wikipedia (http://wikipedia.org)
is an independent and free
encyclopedia on Internet. Its Malayalam
version (http://ml.wikipedia.org) has
lot of articles on various subjects.
3. Email

You have read the letter from a
student in Greece in your Social Science
textbook. Can you write and send a
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Pic. 4.9 Gmail homepage

reply?
There is a facility in Internet to

send messages in the form of text,
pictures, voice, and motion-pictures to
anybody sitting in any corner of the
world. This facility is called email or
electronic mail. There are several web
sites that offer email facility and
addresses free of cost.
Examples: www.gmail.com

www.yahoo.com
www.rediffmail.com

We need an address to receive and

send letters. Similarly we need email
address for receiving and sending
emails.
Activity 3.1

An Email address for you

Go to any web site providing free
email service. Register an email address
by providing your name and other
information required.
Activity 3.2

Collect the email addresses of
your friends and send the emails. Please
do read their replies as well.

Mode of commuication     Advantages      Limitations

Letters
Telephone
Mobile phone
Email
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Conduct a discussion on various
modes of communication and write
down their features in the following
table.
Internet danger zones!

We saw how effectively we can
use Internet to access information and
communicate. Doesn’t it look like an
altogether different world of
information and communication? But
we should be aware of its flip side also.

Indiscriminate use of the Internet may
land us up in trouble. There are lots of
misleading information available on
Internet. You may find information and
pictures that may allure you to
unacceptable tasks and routes.
Therefore, use Internet in the presence
of your teachers or parents, and
according to their directions.

Using Internet for spreading
wrong or obscene information on others
is a punishable offence. In addition to
that, using Internet for any attempt to
destroy or damage the computers or
software is also a punishable offence
under the Cyber Act passed by the
Indian parliament.

Password Security

Password is your secret key to
Internet. Keep it confidential.



Sure you will instantly recognise
these two men in the photographs. A
billion hearts beat in ecstasy  when they
stood on the victory stand flaunting
those cute little things called Olympic
medals. They created history winning
individual medals in the topmost
sporting event in the world. The events
in  which they won the medals, years,

5.  Chemistry made interesting

Pic. 5.1 Pic. 5.2
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and the types of medal that they got
must be etched in your  memories.

Have you ever thought of the
materials which were used to make
those medals? What are the  metals and

alloys that you notice in day to day
lives?

We have studied about numerous
‘elements’ in our chemistry texts. Which
elements among them are  the ones that
you are the most familiar with? How
many elements have you seen or
touched?

• Aluminium
• Silver
•
•
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Pic. 5.3

Element observed Atomic Number Physical State Colour

The Model of Observation Table

There are elements that we see
mostly in the science laboratory. Can
you remember some of them?

• Magnesium
• Mercury
•
•
We are not familiar with several

important elements. We understand
them from photographs and

information available on them. What are
the usual methods through which we
access information on  elements?

There are several software
applications that help us understand
elements. Let’s try to use one such
software called Kalzium, which is
available on GNU Linux platform.

Every element has its own specific
properties. Often it is possible to
understand some of these just  by

observing them. See the element shown in the picture.
Activity 5.1

In ‘Kalzium’, click on the symbols of elements, observe them and prepare
notes on their properties.
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Pic. 5.4

We can access information by clicking on ‘Miscellaneous’ after selecting
the symbol of an element in the ‘Kalzium’ software.

Click on ‘Time line’ on the side bar. We can set the year by moving the
button below the ‘year’ tab.

Click on ‘State of matter’ on the side bar. We can change the temperature
by moving the button below the temperature tab.

Open ‘Kalzium’ software application by clicking ‘Applications’ →
‘Education’ → ‘Kalzium’. Click on the symbols of elements and see their
pictures.

We have understood that different
elements have different properties. We
also realise that this wonderful
universe has been formed by elements.
Water, plants, snow, mountains, and
the celestial objects are all formed by
various compounds of elements.

Elements are behind the nature and
diversity of this universe. How many
of such elements have already been
discovered? Who discovered them?
When? We can learn all these and more
using ‘Kalzium’ software application.

Activity 5.2

Find the following using
‘Kalzium’ software application.
• Which were the elements that our

forefathers knew in pre-medieval
times?

• Which was the first element to be

discovered? When was it?
• Who discovered Silicon? When?
• How did mercury get the symbol

‘Hg’?
• Which were the elements discovered

in the eighteenth century?
• Find out the change in the physical
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Pic. 5.5

state of elements at different
temperatures.

You know the symbols used for
representing elements and their
relationship with the names of
elements. Based on the information
available in ‘Kalzium’ software,
prepare a note discussing the way
elements got their names and symbols,
with examples.

Atom Model

You know the elementary
particles that form an atom. They are
protons, neutrons, and electrons. The
difference in the number of such
particles and the way they are
configured in atoms determine the
properties and peculiarities of
elements.

Picture 5.5 shows the electronic
configuration of an atom. Let’s examine
the electronic configuration of a few
other elements as well.
Activity 5.3

Fill in the following table by
finding out the properties of a few
elements with relatively large atomic
numbers using ‘Kalzium’.

Element Atomic Mass Electronic Configuration
Number.

p n e K L M N O

No. of
Elementary
Particles

Activity 5.4

Find out the elements with more
than five isotopes from the ‘Isotope
Table’ in ‘Chemical Data’. Compare the
number of electrons, protons, and
neutrons of isotopes.

Open ‘Kalzium’ software application.
Click on an element. Access informa-
tion by clicking on ‘Atom model’,
‘Chemical data’ etc.
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Pic. 5.6

The way I made a molecular structure

Prepare a presentation on the information you have collected on an element
from software applications such as ‘Kalzium’ and ‘GPeriodic’. Make a presentation
to the class.

Molecular Model

Sugar, water etc., are substances
of daily use. Can you imagine how the
molecules of these substances would
look like? Have you ever been able to
see them?

We know that molecules are
formed by atoms. But the structures of

Pic. 5.7 -Sugar Pic. 5.8 - Punnamada lake

such molecules are too small to see.
Therefore we make models of
molecular structures to enhance our
understanding. How will you make
such models? Write it down in your
note book.
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Pic. 5.9 - Ammonia molecule Pic. 5.10 - Water molecule

Pic. 5.11

To find elements

Pictures 5.9 and 5.10 show
molecular structures developed using
software. Observe these molecular

structures.
Let’s also try to make models of

molecular structures.

Activity 5.5
H2O NH3 CaCl2

CO2 NaCl CH4

Aren’t you familiar with the
molecules shown above? Now try
developing models of their structures.

How do we develop models of
molecular structures?

Open the appropriate software
application.
• Select atoms of required elements

(See Picture 5.11)
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Pic. 5.12 - Oxigen Atom

To insert Atoms

• In order to bring the atom to the screen, click ‘Draw’ button
first and then click at a desired  spot on the ‘camera view’
screen. See Picture 5.12.

In order to represent a bond between atoms, click ‘Draw’ Select the bond type

Pic. 5.13
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Several software applications are available for making models of
molecular structures. ‘Ghemical’ included in IT@School GNU Linux is one
such software. Open the software and select an element by clicking on
‘Elements’. Bring the required number of atoms to the ‘camera view’ screen
by first clicking ‘Draw’ button and then on any spot on the screen. Select ‘Bond
Type’ button. Place the mouse pointer on an atom and drag to the other to
connect. In order to optimise the molecular structure, place the mouse pointer
on the molecule, click the right button, select ‘Computer’→’Geometry
Optimization’ → ‘OK’. In order to save the molecular structure, place the
mouse pointer on the molecule, click the right button, select ‘File’ → ‘Save
As’, select the folder to which you want the structure to be saved, give a file
name, and press ‘OK’.

Pic. 5.14

button, and place the mouse pointer on
one  of the atoms and drag to the other.

For optimising the molecular

structure, place the mouse pointer on
the molecule, click the right button,
select ‘Computer’ → ‘Geometry
Optimization’→’OK’.

• Try using the tools for
viewing a molecule
from different angles.
Use also the tool for
shifting the position of
the molecule.

• Save this molecular
structure in your
folder and keep it.

• Make more models of
molecular structures,
demonstrate them in
your group and
discuss.
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6.  Games that Matter
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Pic .6.1

You must be familiar with
computer games, and must have
played several of them. Which are the
games in IT@School Linux that you have
played?

Shall we start a new game? You
already know how to find games in
GNU/Linux. Find the game titled
‘Kaliyalla Karyam’ and start playing
‘Design a dream home’. The sketch of a
house (Picture 6.1) appear on the screen.

Not only that, there are also building
materials available! You just have to
build your dream home now!

Everyone goes through a different
experience while trying to build their
dream home. What is your experience?
Try writing it down.

1. The house got demolished.

2. ..........................................

3. ..........................................

4. ..........................................

5. ..........................................

Remember the activity
called ‘Hybridization’ in the
Resource CD? You had done
that while learning
hybridization in the chapter
‘Agriculture: a way of life’ in
the Science textbook. What
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Pic. 6.2

Activity  3        Help

Method 1                              Method 2                                  Method 3

Length (l) = 20
Breadth (b) = 10
Area = length x breadth

Code                Copy

 Back

Variable Content

were the various steps of hybridization?

1. ................................................................

2. ................................................................

3. ................................................................

4. ................................................................

5. ................................................................

6. ................................................................

Let’s start playing ‘Hybridization’ in the
game ‘Kaliyalla Karyam’. The software
tells you how to play when you bring
the mouse pointer on the ‘Help’ button.
Please remember to note down your
observations.

1. ................................................................

2. ................................................................

3. ................................................................

4. ................................................................

5. ................................................................

Remember the activities relating
to coconut production that you did for
the topic ‘Averages’ in mathematics
text? Let’s try doing that through a
game. For this, start playing ‘Average’
in the game ‘Kaliyalla Karyam’.

1. .................................................................

2. .................................................................

3. ....................................................................

4. ....................................................................

5. ....................................................................

Similarly you can also play
‘Difference of Squares’, and ‘Calculating
Speed’. Have all of you been able to
complete the games successfully? What
all did you discover playing these
games?

1. In the game ‘Design a dream
home’, we are able to complete
the house only if we build the
basement, walls, and roof in that
order.
2.In the game ‘Average’................
.......................................................
3. …..............................................
4. …..............................................
5. …..............................................

There are different ways
to calculate the carpet area of a
classroom. Try doing it through
the game ‘Computer
Computation’ (Picture 6.2). Use
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Pic. 6.3

the ‘Help’ button in Activity 3.
Note that there are two different

methods shown for calculating the
carpet area of a classroom. Press ‘Code’
button and you will see a third method.
What are the differences across these
methods?

1. …............................................................

2. …............................................................

3. ...................................................................

‘Code’ is a computer programme.
It is with the help of programmes that
computers understand the ways of
doing calculations.

Now let’s try this programme.
Click ‘Copy’ to copy the programme.
You may note that the third method has
been selected. Copy it to a text editor,
save and run. Please remember to add
a tag ‘.py’ to the file name while saving.
Example: If the file name you have
given is ‘area’, then the file has to be
saved as ‘area.py’.

Now let’s see how to run the
‘area.py’ file.

Open the terminal by selecting
menus/tabs in the following sequence:
‘Appl icat ions ’→ ‘Accessor ies ’→
‘Terminal’. As shown in Picture 6.4, type
‘Python’ followed by file name in
double quotation marks. In this case,

type the following.
Python “area.py”
Press ‘Enter’ and you get the

carpet area of the classroom.
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The language of Computer

We speak Malayalam language. You know that there are several other
languages such as Kannada, Tamil, and Hindi spoken in various parts of
India.

Similarly, there are some languages that computers understand.
‘Python’, ‘C’, ‘C++’ are examples. If you can handle these languages, you
will be able to make computers perform the tasks that you want them to.

‘Open Office Writer’, ‘Open Office Calc’, ‘Impress’, ‘Blender’ etc., belong
to the category of ‘application software’. These application software are
developed using different computer languages such as those mentioned
above. The application software ‘Blender’ has been developed using ‘Python’
language.

Pic. 6.4

If you have to measure the carpet
area of another classroom of size, say,
25’X20', what are the changes that you
will have to make in the programme
“area.py”?

1. Change l = 20 to l = 25
2. ….............................................

If you wish to display ‘AREA =’
before the carpet area, you will have to

add ‘AREA =’ to the command. Then
the command will be

print “AREA=”, a instead of print a
Now let’s run the programme for

finding the perimeter of the same
classroom using Activity 3.

In the window that opens (Pic.
6.5), input the variables for length and
breadth in the boxes below the title
‘Variables’. Type the values in the
corresponding boxes on the right side.
Similarly type the variable representing

perimeter in the third box and the
formula to calculate perimeter in the
box on the right side. Input the variable
for which the value has to be found in
the last box, which has the shape of a
parallelogram. Now press ‘Code’
button. Copy and run.

But if we write programmes like
this, for every class room with a different
length and breadth, don’t we have to
prepare a new programme each time?
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The computer language 'Python'

‘Python’ is an easy-to-learn computer language. This language uses
only fewer symbols than languages such as ‘C’ and ‘Java’. It was Guido van
Rossum who designed ‘Python’. As ‘Python’ is a software with open source
licence, everybody can use this for free.

Pic. 6.6

Pic. 6.5
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Activity 4

Press ‘Help’ button and see the
example. Run the programme in the
terminal. Several activities similar to the
given example can be performed using
this game.

Write down the differences that
you have observed between Activities
3 and 4 in your note book.

1. Difference in activity

...................................................................................

...................................................................................

..................................................................................

...................................................................................

2. Difference in code

...................................................................................

...................................................................................

...................................................................................

...................................................................................

Try solving the following problems
using Activity 3 and 4.

1. Finding the average of two numbers

2. Calculating the speed of a vehicle
using the distance travelled and the
time taken to travel.

What all other programmes can be
worked out using Activities 3 and 4?
Now try these by typing in the text
editor and running it without the help
of the game.

Programming languages like
‘Python’ are used for developing all the
software applications that we use such
as ‘Writer’ and ‘Calc’.

''How convenient it would be if we
could use the same programme for

different length and breadth!''

" voW !!

I  made the computer work
without the help of any software ! "
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7.  Geometrical Constructions

GeoGebra

GeoGebra is a mathematical
educational software application
originally developed by Markus
Hohenwarter of the University of

Salzburg in 2001.
Warter, now at the
University of Florida,
is still working on
improving the
a p p l i c a t i o n .
GeoGebra is a free
software. Anybody
interested in it is free

to learn, improve, and distribute it.

47

Markus Hohen
warter

You are familiar with software
applications for drawing and painting
using computers. Recollect the tools
used in the software. Is it possible to
draw geometric shapes using those
tools? No, because geometric shapes
require a different set of tools. The
standard set includes ruler, setsquare,
and protractor.

There are software applications
that provide the tools for drawing
geometric shapes. What are the
advantages of doing geometric
drawing on computer? Suppose you
have drawn a rectangle and now want
to change the lengths of sides or size of
angles. If the rectangle is drawn on
paper, the only way is to draw a new
rectangle.

This is not necessary when you
draw on a computer. Try and
experience the difference.
GeoGebra

GeoGebra is an educational
software application used for drawing

geometric figures and for observing
their properties.

In order to open GeoGebra, click
Applications→→→→→Education→→→→→ Geogebra
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Pic. 7.2  -  Geogebra Window - Tools

In the opening
window, there are
planar axes and a
panel on the left
side. These are not
required for
drawing. These can
be deactivated by
clicking View →→→→→
Axes View →→→→→
Algebra view in the
menu.

Tools for
Geometric
constructions

The tools in
GeoGebra have been
classified into Groups. We will familiarise the tools in each Group as we move
forward.

Constructions

What is the fundamental construct
in geometry?

A Point.
A point can be marked anywhere

on a plane. Examine the second tool in
the tool box. Use it to mark a point on

the plane.
Let’s now draw a line. First we

have to decide the location of the line
on the plane. We also have to decide
on the direction of the line. In order to
decide these, we need to fix two points.
Let’s mark two points first. Examine
Group III in the tool box. Start drawing

Pic. 7.1 - GeoGebra Window
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Other mathematical software
applications

You have familiarised the
software application called Dr.Geo
last year. It is used for analysing
geometrical problems. There are also
other software applications such as ‘K
Interactive Geometry’ and
‘CaRMetal’.

Squares within squares

lines, joining the points, using the tool.

When you keep drawing lines, you
would realise that many of them are
intersecting. How do we mark the
points of intersection? There is a tool
for this in Group II. Select the tool and
bring it over the intersecting lines.

When two lines intersect, they
form angles. Let’s now learn to measure
these angles.

How many angles do two
intersecting lines form? How do we
specify the angle that we want to
measure?

See Picture 7.4. An angle is
determined by three points. Select the
tool for measuring angles, select three
points which determine the angle that
we want to measure. The measurement
of the angle gets marked in the picture
itself.

Suppose we select three points in

the opposite direction to the above,
which angle will be marked for
measurement?

Mark all the four angles in the
picture. Look for the angles that are in
opposite directions to each other. What
is special about the size of these
opposite angles?

Pic. 7.3 - GeoGebra - Lines
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Pic. 7.4  - GeoGebra - Measures of Angle

Draw several intersecting lines
and see whether the above observations
are true for all of them. Greeks were the
first to make these observations
centuries back. They recorded them on
clay tablets. Now you have got note
books, so note down your observations
in a note book.

Instead of drawing different sets of
lines, can’t we just change the locations
and directions of the points? In fact, this
is the advantage of computer assisted
geometric constructions. We use the
tool ‘Move’ from Group I for this.
Parallel Lines

Suppose you want to draw two
parallel lines. Once you draw the first
line, you can draw any number of lines
parallel to it. But, you intend to draw
just one parallel line. You have to
decide on where do you want to draw
it. Once you decide, just mark a point
and draw a line parallel to the first one
through that point.

Now let’s try using the tool in
Group III of the tool box to draw parallel

lines.
Construction I

Two lines, parallel to each other.
Another line intersecting these two.
Mark the angles in similar positions on
both the parallel lines. Measure them.
Do you find anything special about their
sizes? Will these properties remain even
if the lines have been changed in
position and direction?
Properties of Lines

What are the properties of lines?
Mathematically it has just one property
– length. However, when we draw lines
on a paper, we usually consider several
other properties. For example, we may
draw a thick line (which is not a line
mathematically), may give it some
colour, we may also name it (This we
do in geometry as well), and write the
name at some appropriate place. We
can do all these and more in the ‘context
menu’ of lines.

Check the properties of the line
that you have drawn. Change the colour
of the line and see.
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Geometric Constructions

Geometry is a
very old branch of
mathematics. The
first lessons of
g e o m e t r y
evolved along the
great river of Nile
in Egypt. It has its
roots in the

dispute settling mechanisms used by
small farmers cultivating on the Nile
delta. Disputes were common as the
floods would wash away the
boundary lines of their fields. These
disputes on land rights were the first
problems that geometry addressed.
You may know that the word
geometry means measurement of the
earth. It was Greek philosophers who
consolidated and presented the
discoveries of Egyptians. Euclid of
Alexandria consolidated numerous
discoveries of that time in his classic
‘Elements’ (300 BCE). In ‘Elements’,
Euclid considered those objects that
could be made of lines and circles
alone. (Can you guess why?). We are
living in an age of software
applications such as GeoGebra which
can be used to draw anything that we
can think of. Still, the constructions
explained in ‘Elements’ will continue
to have its historical relevance.

Yuclid

In order to measure the length of
a line, there is a tool (for measuring
distance or length) in Group VIII. Try
measuring the length of a line using this
tool.
Names of Objects

GeoGebra assigns names to all
objects that we create using the
software. We would need these names
subsequently for further work. Let’s
examine the names of the points that we
marked and the lines that we drew.

The name assigned to the line that
we drew here is ‘a’. Draw more lines,
mark more points and check their
names. Do you see any pattern in the
way names are assigned? Could there
be a naming convention used in this?
Mid Point of a Line

We may quite often need to locate
the mid point of a line. The method to
locate the mid point is available in Tool
Group II.

Remember the way we drew
parallel lines. It is also possible to draw
a line perpendicular to another line.
Construction 2

Draw line AB at 8 cm length and
draw a line perpendicular to it from its
mid point. In order to draw a line of 8
cm, it is the tool ‘Segment with given
length’ that is to be used.
Constructing a Triangle

Triangles are formed when three
lines intersect. Draw a triangle using
three lines. Now let’s try to name it. Go
to the context menu of the vertices of
the triangle and check mark ‘Show
Label’. How do we change the name
once given?
Construction 3

You know what Thales’

experiment was. Draw a picture
depicting it. Try moving the Thales
point. See what happens. Write down
your observation in a note book.
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Construction 4

Draw an isosceles triangle (How
to draw it?). Remember the observation
in your mathematics text that the
altitude drawn from the vertex angle of
an isosceles triangle bisects the angle
as well as the base. (Or in other words,
the altitude drawn from the vertex angle
of an isosceles triangle is a median as
well as an angle bisector).

Check whether this is true for all
triangles.
Polygons

A polygon is a closed plane figure
bounded by three or more line
segments. Triangles and squares are
examples. In Group V of the tool box,
there is a tool to draw polygons. Try
drawing a triangle. When you draw,
please remember to complete the figure
by reaching back to the point from

where you started drawing. Mark the
measurements of the sides and the
interior angles.

All polygons have a bounded
area. How do we measure that area?
Don’t you remember the tool that we
used to measure the length of sides? See
what is the next tool in Group VIII. Try
measuring the area of the triangle using
this tool.

You can change the size of the
triangle using the ‘move’ tool. Select the
tool and click on one of the vertices and
drag. See the changes in the lengths of
sides, angles, and area.
Construction 5

Construct a parallelogram. This
requires two pairs of parallel lines.
Which are the opposite angles of the
parallelogram? Is there anything special
about the sizes of these angles? Change

Pic. 7.5 - GeoGebra -  Object name
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the angle sizes and observe the changes.
Construction 6-Circle

Mark a circle on the plane. All the
points equidistant from this point
would form a circle. The distance
between the first point and the other
points is called the radius.

If you provide the centre and the
radius of the circle that you intend to
draw, we can draw the circle using
GeoGebra. The tool ‘Circle with radius
and centre’ in Group VI can be used for
this.

Construct a circle with centre at ‘O’.
Mark any point as ‘A’ on the circle. Draw
a diameter. Remember, diameter is any
chord that passes through the centre of
the circle. Mark the point at which the
diameter touches the circle at the other
end as ‘B’. Mark a third point ‘P’
anywhere on the circle. What will be the

size of the angle <APB? Will the size of
the angle change according to the
position of point ‘P’ on the circle? Write
down your observation in the form of a
statement.

A sequence of area
measurement

Draw a square. Mark the
midpoints of all sides.

Now draw another square with
these midpoints as its corners. You
can use the ‘polygon tool’ for this.
Mark the area of both the squares and
compare. What is your observation?
Repeat the same steps further on the
second square. Does the pattern of
change in area remain the same? In
which other rectangle type can you
observe the same property?

Construction 7

A Circle Containing a Triangle

Construct a triangle and measure
its angles. Draw a circle that passes
through the three vertices of the
triangle. The tool used is from Group
VI, ‘Circle with three points’. Try to
locate the centre of this circle.
Importing Pictures to
GeoGebra

GeoGebra can be used for learning
subjects other than mathematics as well.
In such cases we may need pictures
other than geometric constructions.
Suppose we intend to use the software
for Geography. We may need maps.

Keep a map of India saved in your
computer’s home folder. We can import
this map to GeoGebra using the tool
‘Insert picture’. First decide the location
where you want to have the map. Click
there and select by browsing in the
dialogue box that appears.
Inserting Titles and Captions

‘Insert text’ in Group X can be used
to include titles, captions, and
explanations for the pictures drawn in
GeoGebra. Select the tool and click at
the spot where you want to have the title
or caption.

A window opens. Titles and
sentences can be typed in there.
Check Boxes

Suppose we have to mark
Mumbai port on India’s map.

You may use a symbol to
represent the port. A typical symbol is
a ship. It is possible to mark this in such
a way that it appears only when that
particular spot on the map is clicked.

We can use ‘check box’ for this.
One of the tools in Group X helps in
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Seek your teacher’s support to
arrange it in such a way that the ship
and ‘Mumbai’ appear only when
clicked on that spot.
Construction 8

Insert the picture of a plant cell in
GeoGebra and mark the nucleus and
mitochondrea.
Sliders

If the figures that we draw move
according to our instructions, won’t that
be interesting? ‘Sliders’ are used for this.
These are available in Group IX.

Select the tool and suggest the
location for inserting the ‘slider’. The
window that opens is shown in Picture
7.8. It shows that point ‘a’ can be moved
from -5 to 5. This is the default setting.
We can change it as we want it to be.
For instance, replace -5 by 0 and 5 by
10. Click ‘Apply’. Slider appears on the
plane.

We can now draw a circle, the
radius of which keeps changing
according to the values that we assign
in the slider.

For this we should use the tool
‘Circle with centre and radius’ from
Group VI.

Select the tool and click at the
place where you want the centre of the
circle to be. A window opens where you
can provide the radius (Picture 7.9).

Now that the circle is drawn, check
whether its radius varies with the value
of ‘a’ in the slider. Change the value and
see. Use the ‘move’ tool from Group I
for this.
Changing Angle Size Using
Slider

Slider can also be used to modify
the size of angles. For this, in the slider,

setting up the check box. Use this, find
the name of the check box and note it
down in your note book. Then type in
the text that has to appear when the
check box is clicked on.

Pic. 7.6 - GeoGebra - Checkbox.1

Pic. 7.7 -GeoGebra - Checkbox.2

Open the ‘properties’ window.
Select ‘Advanced’ tab and enlist
‘Conditions to show object’. What is the
condition in our case? The condition is
what we decide as a prerequisite for
exhibiting the label/sentence. Here it
should be ‘While clicking the check box
above’. Select that and provide the name
that you had noted down in your note
book.
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Pic. 7.8 - GeoGebra - Slider 1

Pic. 7.9 - GeoGebra -  Slider 2

select ‘angle’ instead of ‘number’.
(Picture 7.8). The size of the angle ‘α’
on the slider can be anything between 0
to 360 degrees.

Now let’s see how we can
manipulate the interior angles of a
triangle. Activate the slider. Use the tool
‘angle with given size’. In the window
that opens, input the new angle
measure in the ‘α’ tab on the left side.
We can also decide whether we want to
measure the angle in clockwise or anti
clockwise direction.

Now you can see the value of ‘α’
marked as the proposed angle measure

(the size you want to change to). Sides
of the angles will have to be drawn by
joining the new point that appears and
the vertex. Now remove the slider and
see. You can see that the angle size has
been changed. Draw the third side and
complete the triangle. See that the
triangle has been changed.
Construction 9

Draw a circle that passes through
the vertices of the above triangle. Mark
the centre of the circle. What happens
to the centre of the circle when you
remove the slider?

Do you find the two lines passing
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Pic. 7.10 - GeoGebra - Slider 3

through the centre making the figure a
bit too crowded? You may hide these
lines. For this, go to ‘properties’ and
uncheck the ‘show object’ option.
Extra Activities

1. We know that the interior angles of
a triangle add up to 180 degrees.
What will be the sum of the angles
of a rectangle? What about that of a
pentagon? Do you think there is any
relationship between the number of
sides and the sum of angles? Look
for the tool to draw polygons with
equal sides in the tool groups. Then
you can try out more polygons.

2. Construct a square. Mark the
midpoints of all the four sides.
Draw a circle through three points
among these. Note down your
observation. Is it possible to
similarly draw a circle if it was any
rectangle in place of the square?
What all types of rectangles will

allow drawing such a circle?
3. Draw a rectangle. If the two pairs of

opposite angles are equal, what will
you call it? Can you explain your
observations to another person by
keeping two opposite angles
constant while changing the other
pair of opposite angles.

4. Draw a rhombus. Draw both its
diagonals. What would be the
measures of the angles formed by
the intersection of these diagonals?
Write down your observation as a
statement in your note book.

Animated Pictures

Let’s try out a slider. Values can
be from 2 to 5. Let the slope be 1.
Now try out the value of slider in the
tool for constructing ‘regular
polygons’. If you select ‘animation’
in the ‘properties’ window, what
would be the output that you get?
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Pic. 9.1

9. Beyond Calculations

Haven’t you heard the folk tale in
which a man safely crossed the river
with a fowl, fox, and a sack of grains,
carrying two of them at a time on a small
boat?

We can try it out in the game
‘Shore to shore’ which works on GNU/

Linux. How do you start the game? Is it
easy to win? If not, what are the reasons?
...................................................................
...................................................................
...................................................................

In order to successfully complete
this game, we have
to carry beasts and
things from one
shore to the other,
subject to certain
conditions. What
should we carry
first? Next? In
which order to
carry?

........................................

...........................................

..................................

..................................

....................................
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Pic. 9.2

How do we give instructions with
such conditions to a computer? Is it
possible through ‘Python’ language?
Let’s see.

Open the simple computer game
called ‘Magic number’ by clicking in the
following sequence: ‘Application’ ’!
‘Education’ ’! ‘Kaliyalla Karyam’. Click on
‘Beyond calculations’. This is the game
to get your lucky number (Picture 9.1).

Type in your name in the box

provided for it. Click in the box marked
‘A’ and type in a single digit number
(magic number). Click ‘Enter’. See the
change in the boxes C and D. When does
‘Congratulations’ appear in box ‘D’
indicating success?

Suppose you succeeded on
typing ‘5’, what would be the statement
among the following, lying hidden in
box ‘B’?

• If the number typed in ‘A’ is ‘5’, then
let ‘Congratulations’ appear in box
‘D’ (A=5).

• If the number typed in ‘A’ is greater
than ‘5’, then let ‘Congratulations’
appear in box ‘D’ (A>5).

• If the number typed in ‘A’ is smaller
than ‘5’, then let ‘Congratulations’
appear in box ‘D’ (A<5).

For the right answer, click on the
question mark in box ‘B’ (Picture 9.2).

Note that it is when A=5 that
‘Congratulations’ appear in box ‘D’.

You can also develop games like
this. Try Activity 6 (Picture 9.3).

Write down the first few steps as
statements as we have seen earlier.
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• Instruct to type in name
• Instruct to type in a single digit
• If the digit is ‘5’

°  Show ‘Congratulations’ as output
else
°  Show ‘Try again’ as output

In order to execute a programme
as per the above statements, we need
the following.
• ‘Character input’ for typing in name

• ‘Number input’ for typing in a digit
• A ‘decision’

Go to the tool list on the left hand
side, click on the buttons ‘Character

Pic. 9.3

Number Input and Character Input

If a programme has to accept numbers as inputs, the tool ‘number inputs’ will
have to be selected from the tool list. For the programme to accept characters
as inputs, the tool ‘character inputs’ has to be selected from the tool list.
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If the typed number is 5, confirm
your success in D.

… … … … … … … … … … … …

………………………………..

If s < 5 Instead of s=5

……………………………………

If n, congratulations  instead of con-
gratulations
………………………...................

… … … … … … … … … … … … …

Table. 9.1

Pic. 9.4

Find out the changes that take
place in the working of the game when
the following changes are made in the
content of each box.

Click the ‘code’ button in the game
and see the computer language
corresponding to the above changes.
Save it and activate.

inputs’, ‘Number inputs’, ‘Decision/
comparison’ in that order. Type in
variable and content as shown in Picture
9.4, and click ‘Code’ button.

You can see computer language
(Python) appearing on screen as shown
in the Picture. Paste it in ‘text editor’,
save, and run.
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input

raw_input

=

==

<

>

print

if

Table. 9.2

Try writing down the functions of
the statements and symbols in the
computer language (Python).

Make adequate changes in the
game using the buttons ‘variables’,
‘input’, ‘output’, ‘comparison’ and do
the following activity.

Accept the distance travelled and
time taken for travel by two vehicles
and find the faster vehicle.

Will you try finding more
activities like this from your textbooks?
......................................................................................
.......................................................................................
......................................................................................

Recollect the computer games that
we played, and the various computer
applications that we used (Sunclock,

Marble, Calc etc.). Think about how
these applications must have been
working. For the ‘Sunclock’ to show the
time differences across countries,
statements like the ones used above
must have been used. It is codes
(programme) like this that help Calc
provide the sum of the digits in two
cells in a third cell. It short, it is the
working of several programmes like the
one we made in Python that work
behind software applications such as
‘Sun Clock’, ‘Marble’, and ‘Calc’.
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Pic. 8.1 Spreadsheet window

8. Tabulate and Analyse

How many books do you have in
your school library? There must be

books on several subjects by several
authors. How do you figure out the
titles and authors available?  The library
register might provide you with the re-
quired information.
And what if you are to assess the physi-

cal fitness of students?  It can be done
based on various tests. Likewise, we can
collect information on different topics
from different sources. How do we put
such information to the best use? We
have to analyse them and draw infer-
ences.
Suppose you want to conduct a cam-

paign to check the
height and
weight of each
student in con-
nection with the
increasing obe-
sity in teenagers,
what are the de-
tails to be col-
lected?
............................
............................
Based on the in-
formation col-
lected classify
and analyse them
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Pic. 8.2

first to arrive at a conclusion. It will con-
sume more time and effort if you are to
classify such information of all the stu-
dents in your school.
But with the advent of computers such
exhaustive and time consuming tasks
could be executed very easily and
swiftly.
You are now familiar with the applica-
tion software called Spreadsheet. The
OpenOffice.org Calc is a Spreadsheet
software that enables you to carry out
such activities.  Write down the steps
to open the Open Office .org Calc.

Applications J …………….

What are the special features of the
spread sheet window?

1. A sheet of paper with rows and
columns.

2. … … … … … … … … … … …

3. … … … … … … … … … … …
4. The small rectanugal boxes cross

are called cells.
5. ……………………………….

Each row and column has a name by
which it can be identified. Locate the
place where it is indicated.

The columns are named on top by
the English alphabet A,B,C……..etc,
and each row is numbered on the left
by 1,2,3,……,etc.

Click the mouse pointer on any cell.
Look at the left top above the column
header for indication.
You have now identified the cell ad-
dress. Write down the name of the shad-
owed cells as shown in the picture 8.2
1…........, 2…........, 3……..,
4……..., 5…..…., 6….….,
7…….., 8………



Tabulate and Analyse

59

Pic. 8.3 Table

Activity

Imagine that you are preparing a
family budget for the families in your
village. Let’s go through the particulars
that are essential to prepare the budget.
You should be aware of the existing
expenditure.  Collect details of the pre-
vious month’s expenditure from each
family.
Select 10 houses and collect the details
of expenses on the following items :

1 Food
2. Clothes
3. Conveyance
4. Education
5. Miscellaneous

From these find out the answers to the
questions given below:
1. Which family has spent the most?
2. For what purpose did they spend

the highest expenditure?

3 What is the average expenditure of
a family?

4. Which family has spent more
on clothes?

Now, let us enter the details collected
in the spread sheet and sum up the ex-
penses of families to prepare a model
budget.
You have collected only the number of
houses and the expenses. Suppose  you
want to enter the name of the house
owner along with other details, just in-
sert another column in between house
number and food.
You have included the name of the
house owner in the spread sheet. Now
insert column on the left for the serial
number.
Type ‘Monthly Expenses’ on the top of
the table by inserting a row.
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To insert a coloumn / row

1. Put cursor where the row / column is to be
inserted

2. Click on Insert - Column/row

Pic. 8.4

Pic 8.5  shows the columns with the House owner and serial no.

Now, how will you include the serial
numbers in the selected column? Do
you know any easy method to include
the serial numbers in the column? Seek
the help of your teacher if required. In
order to make ‘Monthly Expenses’ that
you have typed in the first row,  select

the cells there and merge them into one.
Merge cells with the help of directions
given in the box.
How to delete any of the rows or col-
umns from the table?  Seek the assis-
tance of your teacher.
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Pic 8.6 with typed title

Pic. 8.7  Merged title of the table
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There are many methods to find out the
total expenses. Use any one of the meth-
ods to get the total expenses of each
family.
Find out the average expenditure of
each family. The formula is known to
you It’s the sum divided by the num-
ber of entries.
How will you find out the family that
has spent more? It is easy to find out
the  details of ten families by verifying
the table at a glance.  Suppose you have
included all the houses for this project,
how would you find out an answer to

the above question? Verifying the long,
detailed list is a difficult task. To make
it easier the software spread sheet has
a method called Sorting
Pictorial representation enhances un-
derstanding of the subject.  The graph

Merging cells

1. Select the cells for merging.
2. Click in the following order:

Format  J Merge Cells J Merge
and Center Cells/Merge Cells.

For the merging of cells in the
centre, use the option Merge and
Centre.

To find the sum total

Method 1 –Auto Sum
1. Select the cell to insert the total
2. Click the icon  in the formal bar
3. Press the enter key.
4. To obtain the sum

a) Select the first cell (the cell that display total sum)
b) Bring the cursor on the right corner of the cell.
c) When the cursor assumes the form of +  sign, press the mouse

button and drag to the bottom
d) Sums will be obtained in the required cells below.

Method 2
a) Select a cell to insert  the total
b) Type = sign in that cell.
c) Click on the first cell to find out the sum. You can view the ad

dress of the cell  on the right part of the  sign ‘=’
d) Type + sign.
e) Click on the next cell.  Make sure that you have included the

addresses of all the cells and press the enter key

How to delete row

1.  Select the row to be deleted
2.  Edit J Delete cells
Same procedure is applicable for
deleting the columns

To find out Average

♦ Select the cell to insert the aver
age

♦  Type ‘=’
♦ Select the cell where the total

marks is inserted.
♦ Type the sign ‘/ ‘of division
♦ Type the numbers of details.
♦ Press the Enter key.
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Pic.  8.8  Table showing sums

Pic. 8.9
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Pic. 8.10

or diagram based on any information reaches the minds clearly and vividly.
Let us prepare a graph for the project on ‘family budget’
To draw a graph

1.  Select the facts to be included. (Pic. 8.9)

2.  Click on Insert J Chart

3.  Select Chart type

Pi
c.

 8
.1

1
Pi

c.
 8

.1
2

Method of Sorting

1. Select the table as a whole.
2. Data - Sort
3. Select the column to be

sorted in the Sort by
4. Select from the option

as cending/descending
5. Click OK
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   Year Male Female Total
1977 --˛80 139 1

1980˛82 135 5

1982˛87 136 4

1987˛91 132 8

1991˛96 132 8

1996˛2001 127 13

2001˛2006

2006˛2011

   Year                                   Kerala %                                  India %
1961 55.08 28.03

1971 69.75 34.45

1981 78.85 43.57

1991 81.81 52.21

2001 90.92 64.84

4.  Examine the range of the data included. You are free to make necessary changes.
5. Insert, if necessary, the title x-axis or y-axis on the tab Chart Elements.
6. Specify the place to insert the chart.
7. Click the Finish key.

More Activities

1. A table given below shows the total number of MLAs in the Kerala
Legislative Assembly for the last few years. Find out the total number of
MLAs using the Open Office.org Calc.

2. The literacy rates of Kerala and India during various years are given below.
Prepare a graph showing the literacy growth of Kerala by using
OpenOffice.org Calc

3. Given below are the scores awarded by various judges for the participants
of digital painting competition in the sub district level IT Fest 2009-10. Using
OpenOffice.org Calc calculate the total score of each participant and find out
the winner. Also draw a graph showing the level of participants.
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Participants Judge 1 Judge 2 Judge 3 Total

A 60 42 51

B 59 51 48

C 72 68 69

D 52 48 49

E 69 59 71

4. The table below gives you details about the temperature of important cities
telecast by Doordarshan News bulletin. Find the average temperature of
three cities.

                                       Maximum      Minimum
     Cities                      Degree Celsius     DegreeCelsius     Average

  Thiruvananthapuram       32                            22

  Kochi                               33                            26

  Kozhikode                               25                            17
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Pic. 10.1 Globe

10.  Map Reading

72

Can you think of learning
geography without globe and maps?
Why do we use them? Can you note
down the types of information that we
get from globe and maps?

Of late, software applications
used for reading maps have become
very popular. ‘Marble’ is a simple
software in this category. It is basically
a desk top globe.
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Map Reading
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Activity Corner

♦ Click the tabs in  'View' menu and see the changes in the globe.
♦ Click the tabs 'Navigation'. 'Legend', 'Map view' given on the left side

panel of the 'Marble' window and observe the changes.
♦ Click on 'home', 'arrow', 'zoom' tabs and see the changes in the globe.

Watching the Globe

Open the ‘Marble’ window in the
‘Education’ menu and see the globe.

Complete the activities suggested
in Activity Corner below.

Watching Kuttanad

Zoom in onto the area
representing the Vembanad lake in
Kuttanad and observe it.

Can you prepare a list of the
places around Vembanad lake?
Longitude and Latitude

Zoom in to your place on the
‘Marble’ globe and see the places. Bring
the mouse arrow above those places
and see their longitudes and latitudes.

Can you locate the meridian
opposite to the prime meridian and
write down its longitude?
Measuring Distance

What is the distance between
Thiruvananthapuram and Delhi? We
can find this out from ‘Marble’ globe.

Zoom in to Thiruvananthapuram.
Click the right button of the mouse.
From the menu that opens, select the tab
‘Add measurement point’ by clicking
the left button of the mouse. Similarly,
zoom in onto Delhi, and select the tab
‘Add measurement point’. See the
distance that the software shows. Please
note that what is shown is the aerial
distance between the two places. Rail

or road distances will be more than
that.

By tracing the sea route from
Portugal to Kozhikode by means of
mouse clicks, can you estimate the
nautical miles that Vasco Da Gama
travelled in 1498 to reach Kappad?
Content of Maps

Prepare a note on the types of
information that globes and maps
provide.

Let’s now run the ‘Marble’
window in ‘Legend mode’ for accessing
information. See the list of legends
shown in the box on the left side. Select
the following legends from the list by
clicking on the check boxes.

• Cities
• Water bodies
• Ice and glaciers
• Relief
• Coordinates
• Grid
• Scale bar
Observe the changes on the globe

now. ‘Uncheck’ the check boxes and see
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Pic. 10.2   Legend Tool bar

Pic. 10.3
'Marble' maps

the difference. (Picture 10.2).
Different Types of Maps

Geographers use various types of maps for different
purposes. Observe different maps using the ‘View’ tab in
‘Marble’. (Picture 10.3).
Xrmap for Map Reading

Maps are essentially repositories of geographic
information. They may also contain information on various
matters such as roads, buildings, administrative
boundaries etc. Digital maps are capable of containing
much more information than the ordinary maps used in
class rooms. Open ‘xrmap’ provided in the ‘Education’
menu and observe the types of information stored in digital
maps (Picture 10.4).
Scales of Maps

We know that maps are prepared in different scales.
Open ‘xrmap’ and see a map in a small scale. Press ‘+’ key
to see map of a larger scale. Observe the difference between
the two. Which one provides more details?
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Pic. 10.4 Xrmap window

Click on the red marks on the map and
see the features available in the tool bar.
Find out the use of these features by
pressing ‘Z’ key (Picture 10.6).

Mark your school on online maps such
as ISRO, Bhuvan, and WikiMapia.
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Pic. 10.4 Xrmap toolbar

Pic. 10.6 Xr Keyboard Shortcuts
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11.  Effective Presentation

All of you love watching movies,
don’t you? But have you ever

thought that the movie you watch on
the screen is the outcome of several days
of hard work and that it is the product
of combined effort of many people? The
development of Information and Com-
munication Technology has
revolutionised the way films are pro-
duced. Don’t you want to present a
story effectively in front of an audience?
How will you stir the emotions of the
audience?
For effective presentation a lot can be
done by utilising the techniques of ICT.
The ICT can make your learning pro-
cess more effective and motivating. The
ICT can be used to cover many such ar-
eas of your learning activity.
What all ICT techniques do you know
to make your presentation more effec-
tive and attractive?
♦ Pictures
♦ Sound
♦ ……...............................................
♦ ……...............................................

♦ ……...............................................
♦ ……...............................................
You have already understood that the
presentation software helps you to
present your ideas using sound and
images.

Impress in Open Office.org is a pre-
sentation software that works in
IT@school Gnu/Linux.

Note down the preparations to be made
to make an effective presentation using
the materials that you have collected as
part of your learning activity.

♦ Decide on the key points to be pre
sented before the audience.

♦ Decide where the visuals and sound
will have to appear.

♦ ……...............................................
♦ ……...............................................
♦ ……...............................................
♦ ……...............................................
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A storyboard is a visual layout of
the images and text you want to
appear on each slide.

Slide 1   Water, the elixir of life
An image of a fresh water source
Font Size  ...........................................
Font Colour .......................................

Slide 2 Total amount of water on
earth, Pure water - a table

Font Size  ...........................................
Font Colour .......................................

.............................................................

Slide 3 Availability of water in
our area - a study

The information you collected during
the project can be given here as a
hyperlink

Slide 4
Environmental factors that
lead to water contamina-
tion.

The video and pictures showing
water contamination ..............................

Slide 5
The images on proper uses
of water

Collect photographs of water recy-
cling  with the help of your teacher or
photograph it  from your area (if avail-
able). Use them here.

Slide 6
Water Conservation -
Important Points

Suggestions  for educating public on
preservation of water should appear
here  ..............

Suppose you want to create a presenta-
tion on a topic ‘Importance of Water
Conservation’ based on the 16th chap-
ter of Basic Science textbook in connec-
tion with the awareness campaign. An
incomplete story board is given below.
Complete it to create an effective story
board.
Suggestions should appear here on your
action plan to preserve water.
The completed story board can be used
to create a presentation on the topic. Let
us see how presentation can be pre-
pared on the topic with the aid of

OpenOffice.org Impress.
Record the details to be included in the
slides and complete the story board in
your ICT note book. A discussion in the
group will help you to improve the
matter.You can even make necessary
changes in the story board while you
prepare the presentation.
From the 'Tasks' on the right side of the
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To include pictures

Select the slide to add the picture.  To add a picture Click the mouse in the fol-
lowing order.  Insert →  Picture 

→

 From File.

Pic. 11.1

slide, choose a suitable lay out for the
presentation. Type the required details
on the selected slides.
You have now typed the matter in each
slide as stated on the storyboard. Let

us see how to make the slides attrac-
tive, using the infomation given below.
You can seek your teacher’s help, if
needed.

How to include a movie file or a
sound file

Select the slides to be added.  Click the
Movie and Sound in the Insert Menu to
add animation and sound files. (Pic.
11.2)
How to give Hyperlink

Select the words in the slide to be
hyperlinked. Click on Hyperlink and a
window opens. Click on Document on
the left side of the window (Pic. 11.3)
Click on Folder icon on the right side of
the window and browse the file to be
connected to the slide. Type the words
selected from the slide in the space of
Text and click the Apply
button.

How to animate the slides

Select the words or pictures to be ani-
mated. Click in the following order:
Slide Show

→

Custom Animation (Pic.
11.4) Now suitable animation can be
added to the slide by clicking the Add
button in the Tasks pane appearing on
the right side of the slide.
We have learned how to make the
slides attractive by adding animation
and sound to it. The presentation of
slides also deserves equal importance.
One has to decide on the order of its
appearance.  It should never be shown
in quick succession as that can distract
the viewers.  For an effective presenta-
tion, the slides have to be in logical or-
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Pic. 11.2

Pic. 11.3

der and will have to be properly con-
nected to each other. Many different
slide transitions are available in Open
Office Impress. Slide Transitions are
one of the many finishing touches to a
presentation. Wait until you have the
slides edited and arranged in the pre-
ferred order before setting. You might

have noticed the order and emergence
of each scene in a movie.  Do it likewise.
Click Slide Show and then Slide Transi-
tion respectively.
Find alternate method if any and record.
1 … … …
2 ……....

3 ……..

4 ……..

5 ……..

6 ……..

7 ……..

8 ……..
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Pic. 11.4

Don’t forget to save the presentation in
your folder. Try to do the activities
given below using Impress and present
it during the Free Software Day.
Activities

1. Prepare a presentation on Kerala’s
mineral wealth.

2. Prepare a presentation on the ‘Struc
ture of Cell’ that appears in the Unit
titled ‘The Casket of Life’ in Basic Sci
ence.

3. Prepare a chart in a Spread Sheet on
the production of crops in India and
the total cultivable land during the
last few decades. Prepare a presen

tation on “The Agricultural Scenario
– After Independence“and insert the
spread sheet as hyperlink.

4. Prepare a presentation on William
Shakespeare  highlighting the  story
Macbeth in your English Course
Book

5.  Prepare a visual presentation of the
poem “The Enchanted Shirt” in
English Course Book.

6. Prepare a presentation with ample
pictures highlighting the traditional
agricultural rituals of Kerala in con
nection with the lesson titled
“Arisree’ in your Malayalam
Course Book.
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12.  Far out in the Sky

Pic. 12.1

Boundless and enigmatic as they are
The incredible ways of the Planet Earth
Little could a man sitting in a remote corner
Grasp its fathomless depth and form

We watch the sky during the day
and night. When do you think the sky

looks the most wonderful? You must
have observed several changes

happening in the sky.
Watching the sky with
hundreds of stars,
planets, moon, and the
sun must be
something dear to
your heart.

When was it that
you have watched the
sky seriously in the
recent past? Were you
looking for something
specific? Did you find
any problem in
watching the sky?

Try writing
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Open Kstars software application and set our place using ‘Settings ’!
Geography’. If our name is absent in the list, click ‘clear fields’. Set ‘city’, ‘state’,
‘country’, ‘longitude’, ‘latitude’, and ‘UT Offset’ (the time difference between
Greenwich mean time and our local time). Click ‘Add to list’ to include place
name. For example, in order to include the place name Alappuzha, provide
the following: Alappuzha, Kerala, India, 76 23, 09 30, 5.50.

Pic. 12.2 ‘Pic. 12.3

Open Kstars software application and set ‘Time’, ‘Date’, and ‘City’. Click
‘Pointing ’! Find object’. Press ‘Enter’. You can see the moon closer by clicking
‘Zoom in’ button. Click ‘Time → Set time’ to set date and time.

Observe Moon

down your experience in sky watching.

•

•

•

‘Kstars’, ‘Stallarium’ etc., are
software applications that help us watch
and understand the sky better.

Have you observed the changes
that the moon undergoes, starting as a
crescent the next day after the new
moon and progressing towards the full

moon? We can observe these changes
in the shape of the moon using Kstar
software.
Activity 12.1

Refer the calender and figure out
the dates of new moon and full moon
this month. Use Kstars to observe the
changes in the shape of the moon
through the cycle.

Have you seen solar eclipse?

Set the ‘place’ in Kstars software
application. Set the ‘date’ as 15th
January 2010. Set the appropriate time
in the ‘Adjust time step’ option in the
Tool bar. Click the ‘Start clock’ button.
Sky Watching in Different
Months

Picture 12.5 shows the sky on a
day in February. Observe the sky on
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Pic. 12.4

‘Pic. 12.5

different days in other months.
What all celestial objects have
you seen while watching the
sky?

• Stars
• Planets
•
•

Let’s See Star Constellations

If you watch the sky every month
regularly, you will notice constellations
of stars in different parts of the sky. Our
ancestors have joined them by
imaginary lines and have attributed
certain shapes to them. These shapes
are mostly of animals or people. These
constellations are known by these
shapes.
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Type ‘Orion’ in the ‘Pointing → Find
Object’ window. Press ‘Enter’.
(Picture 12.6)

We can use Kstars to locate these
constellations. Let’s take the
constellation which has the shape of a
hunter (Orion).

Try to observe the following while
watching the stars:
• How many stars are there in the

‘Orion’ constellation?

Pic. 12.6

• Which is the brightest star among
the Orions?

• What is the relationship between
Orion constellation and directions
as we understand them on Earth?

• Repeat the observations on different
days and months

Gemini, Aries, Cancer, and Leo
are constellations of different shapes.
Observe each constellation, count the
stars, look for the brightest star and see
the shape of the constellation and relate
it to its name.

Pic. 12.7 Pic. 12.8

You know the composition of the
solar system. You also know the time
that the earth takes to revolve around
the sun once. But do you know the time
that Saturn takes to revolve around the
sun once? What about other planets?
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Pic. 12.9

Activity 12.2

Open the Kstars software. If you
select ‘Tools’ and click ‘Solar system’,
the window shown in Picture 12.9
opens. First set the time in the tab
provided for that. Now click on the
button on the left side and start

observing the planets. Note down your
observations. Set a different time and
repeat the activity.

Set the time on the computer and
click the ‘Today’ button and see what
happens.
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